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Hold and Fetch

The Hold and Fetch commands, found on the Edit menu, are used together. When you use the
Hold command, it saves a temporary file with the contents of your scene, bookmarking the
present state of your scene. Then, when you use Fetch, 3ds Max loads the contents of the Hold
file, restoring the scene to the state is was in when you used Hold.

Note: Neither Hold nor Fetch affects the state of your saved .max scene file.

©

My Dog.max
Hod Hold and Fetch can be seen as a temporary save,
O

- leaving your actual .max file intact

maxhold.mx

My Dog.max Fetch

Merging Files
Merging files is a method of combining all or part of one 3ds Max scene into another. While you

have a 3ds Max file, using the Merge function prompts you to pick another scene file. After you
specify a .max file, you can choose to merge some or all of the elements in the scene.

When you merge a file, you take objects from one file (e.q., My Dog.max) and
place it in another (e.g., DogHouse.max). The My Dog file is unaffected by this
operation, but The Doghouse file has new objects in it.



Save Selected

The Save Selected command on the File menu lets you take selected objects and save them to a
.max scene file. You could look see it as the reverse of merging objects from a file.

The Doghouse with Dog.max

(Doghouse Object Selected) When you use Save Selected, whatever is

selected is saved to a file

Save
Selected

©

The Doghouse.max

Import and Export

The Import and Export commands are used to bring files of various formats into and out of 3ds
Max. The Import command brings in files from many other programs, such as 3D Studio® DOS,
AutoCAD®, Adobe Illustrator, MotionBuilder™, and Lightscape, among others. The Export

command saves 3ds Max scene files into most of the same file formats that Import supports. It
also exports to the new 3D DWF™ file format supported on the Web.

File Link and XRef

The File Link and XRef toolsets allow you to combine files. They are meant to be used within a
collaborative environment. That is, these commands are designed to maintain a live link between
the files, so that changes in one linked file are reflected in another.

Starting your Scene

When you start 3ds Max or choose the Reset command from the File menu, the workspace
contains a new scene that has yet to be named. You can begin working immediately, using the
default scene setup, units, and grid setup. If you want to work in a different environment, you can
change the scene setup using commands from the Customize menu.
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Units Setup
The Units Setup command from the Customize menu lets you change the units in the scene.

units setup 21 x|

 Display Unit Scale
 Metic
IMeters 'l

£ LS Standard

IFeetw.-"Dec:imaIInc:hes j I‘I.-"S j
Default Units: % Feet € Inches

¢ Custam
FL = [eE0.0 IMeters j
& Generic Units The Units Setup dialog. You can choose linear units to be
r— Metric, US Standard, Custom, or Generic
r Lighting Uit
I International - l
QK | Cancel |
Grid Settings

The Grid and Snap Settings command on the Customize menu brings you to a dialog with four
tabbed panels. The Home Grid tab gives you options for changing the grid settings in your scene.

=T

Snaps| Options | Home Grid | Uszer Grids |

e Ll

Grid Spacing 100 2|
b ajcr Lires eveny Ntk Grid Line:[T0 prs
Perspective View Grid Extent:[7 ﬂ

[V Inkibit Grid Subdivision Below Grid Spacing
[V Inkibit Perspective View Grid Resize
r— Dynamic Update

® Active Viewport ¢ AllViewports

Grid spacing is the number of units between grid lines. Major Lines Every Nth Grid Line
determines where a heavy grid line will appear.

—
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Base Plane
Major
S | |u'
Lines
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EXERCISE 1: UNITS AND GRID SETUP

In this exercise, you'll set up the units and grid of a scene file.

1.

2,
3.

4.

Start or reset 3ds Max.

From the Customize menu, choose Units Setup.

On the Units Setup dialog, choose Metric, and then open the drop-down list.

Syztem Unit Setup

21|

 Display Unit Scale
& Metic

Meters ﬂ

#~ |Centimeters -
Kilometers )

Default Units: % Feet € Inches

£ Custam

FL = [6E0.0 I Meters

 Generic Units

]

r Lighting Uit

I Intemational = l

()3 | Cancel |

The Metric unit type gives you four
choices of metric units

Choose US Standard units, and look at the choices from its associated drop-down lists. The
second list is available only when you choose an item with “Fractional” in its name from the

first list.

Next, choose Custom units, and open the drop-down list at the right, with choices

for Custom.
Syztem Unit Setup

21|

 Display Unit Scale
 Metic

I IMeters x l

£ LS Standard

IFeet w/Decimal Inches j I‘I.-"S
Wefault Wnits: & Feet £ Inches

& Custom

FL BE0.0 Meters

 Generic Units Feet
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-

()3 | Cancel |

The Custom unit type gives you the ultimate flexibility;
simply identify the unit and specify a multiplier of a
known US Standard or Metric unit
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6. Finally, choose Generic Units and then click OK. Generic Units is the default choice for 3ds
Max scenes.

EXERCISE 2: OPTIONS FOR GRID DISPLAY

Next, you'll look at some of the options for grid display.

1. From the Customize menu, choose Grid and Snap Settings.
2. Inthe dialog that appears, click the Home Grid tab.

In the next two steps, you'll set up the grid of the 3ds Max viewports to match a games engine
that works with a foot measure that is subdivided into 12 units. Then you'll give yourself a heavy
grid line, so you can easily see each five-foot interval.

3. For Grid Spacing, enter 12. This represents the number of units in a foot.

4. For Major Lines Every Nth Grid Line, enter 5.

=T

Snaps| Options | Home Grid | Uszer Grids |

God Ly

Grid Spacing:[16.0

Major Lines every Mth Grid Line:l 5
Perspective Wiew Grd Extent:[§

EE|REEE

[V Inkibit Grid Subdivision Below Grid Spacing
[V Inkibit Perspective View Grid Resize
r— Dynamic Update

® Active Viewport ¢ AllViewports

5. Close the dialog by clicking the X button in the upper-right corner.

SIMPLE GEOMETRY CREATION AND PIVOT POINTS

When you create an object in 3ds Max, it's important to note that it contains an element called a
pivot point. The pivot point is the point about which an object's transformation occurs.

Pivot Point Location

The location of a pivot point is usually chosen by default, but you can always move the pivot point
if needed.

EXERCISE 3: SIMPLE GEOMETRY CREATION AND
PIVOT POINT LOCATION

In this exercise, you'll create a simple geometry and set its pivot point.

1. Start or reset 3ds Max.



On the Create panel > Object Type rollout, click the Box button.

|7 5 @@ T|
o3 v & 0. 22 %

Standard Primitives hd

;

F - Object Type |

id ™
Box Caone

Sphere GeoSphere

Cylinder Tube
Torug Pyramid

Teapot Flane

Right-click the Perspective view to make it active, if necessary.

In the Perspective viewport, drag to define the base of the box.

Release the mouse button, move the cursor vertically, and click to set the height of the box.

Your box object should look
something like this

You can create most 3ds Max built-in objects with click-and-drag operations.

33



84

6.

Press the F3 key to switch to wireframe display.

ri ==

The XYZ axes at the base of the object show the location of its pivot point.
M On the main toolbar, click the Select And Rotate button. A spherical Rotation gizmo

replaces the previous pivot point icon.

Each color-coded circle represents rotation about a given axis. Remember RGB = XYZ, so
the red circle rotates about the X axis, green about Y, and blue about Z. The outer gray
circle rotates perpendicular to the direction of the view, and the inner gray circle allows

free rotation.



8. Click and drag the red circle. The red circle becomes yellow when the cursor is over it.

Dragging the red circle rotates about the X axis.
9. Press CTRL+Z to undo the rotation.
10. ﬁ Click the Select And Move button.
1. Go to the Hierarchy panel.

B CIERY

[Bos0t ||
Pivat K. Link Infa

[- Adiust Pivot |
Move/Rotate/S cale:

Affect Dbject Only

Affect Hierarchy Only

=

|

15

12. Click the Affect Pivot Only button to activate it.

:
-

When Affect Pivot Only is on, the pivot gizmo is displayed more prominently. While Affect
Pivot Only is active, transformations such as Move affect the pivot, not the entire object.



13. Drag the blue arrow on the pivot to move it to the top of the box.

Hint: You might want to pan the view down if you cannot see the pivot point icon at the top of
the box.

—

14. Click Affect Pivot Only again to turn it off.
15. O Click the Select And Rotate button.

16. Drag the rotation gizmo's red circle. Now the box rotates about its top instead of its base.

Rotation takes place about the pivot, which is now on the top of the box.



OBJECT ORIENTATION

When you create an object in 3ds Max, the initial orientation of the object is determined by the
viewport where the object is created. Each viewport has a base plane where Z=0; this is where the
objects are created.

o _
E E
o
\\
™~

. ’//

Creating cylinders in the Top, Front, and Left viewports is like creating these objects on the floor,
front, and side walls of a room.

Pivot Point Orientation

The pivot point of an object is affected by the view in which the object is created. In the case of a
cylinder, the Z-axis of the default pivot point is parallel to the height of the cylinder.



In the Top viewport, create a cylinder below and to the left of the center of the view. After
dragging out the base, move the mouse and then click to set the cylinder's height while
observing the height in the other viewports.

- |

Right-click the Left viewport to make it active.

Create another cylinder, this time to the right and above center.

H

3 (Y

Right-click the Front viewport to make it active.



8. Create a third cylinder to the left and above the center.

9. Right-click the Perspective viewport, then press the F3 key to set the display to
wireframe mode.

10. W On the main toolbar, click the Select Object button. The button appears yellow when
the tool is activated.

1. Go to the Hierarchy panel. Turn on Affect Pivot Only.

B CIERY
E—
Pivat IK Link Infa

[- Adiust Pivot |
Move/Rotate/S cale:

Affect Dbject Only

Affect Hierarchy Only

12. The last cylinder should still be selected. Hold down the CTrL key, then click the other two
cylinders to select them as well.

The blue arrow in the pivot, representing
the Z-axis, points away from the base
plane of the viewport that was active
when the cylinder was created.
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MODIFYING STANDARD OBJECTS

When you create an object in 3ds Max, a standard practice is to switch from the Create panel to
the Modify panel before making changes to the object's parameters. Often you'll create an object
“by eye” in the viewports, then change its dimensions to round numbers.

[= Parameters | = Parameters |
R adius: W ﬂ R adius: ISD— ﬂ
Height: [37.548 3 Height [300 2]
Height Segments: |5— ﬂ Height Segments: |5— ﬂ
Cap Segments: I‘I— ﬂ Cap Segments: I‘I— ﬂ
Sides: I‘Ia—ﬂ Sides: I‘IS—Q
v Smoath v Smoath
[ Slice On [ Slice On
Slice Fram: IDD— ﬂ Slice Fram: IDD— ﬂ
SlceTa:[00 |3 SlceTa:[00 |3
¥ Generate Mapping Coords. ¥ Generate Mapping Coords.
[~ Realworld Map Size [~ Realworld Map Size

On the left, the cylinder has fractional Radius and Height values after creating it by clicking and
dragging in a viewport. On the right, the Radius and Height values have been changed to round
numbers.

On the Modify panel, and throughout 3ds Max, you can animate numeric values, such as the
Radius and Height of a cylinder. Parameters represented by check boxes or radio buttons usually
cannot be animated.

= Parameters

R adius: ISD— J
Height: Im_ J
Height 5egments: |5— J
Cap Segments: I‘I— J
Sides: I‘IS— J
v Smoath
I~ Slice On

Slice Fram: |D.D ﬂ

Slice Te: [0 E

V¥ Generate Mapping Cocrds.
[~ Real‘world Map Size

The check boxes shown represent values that cannot be animated.
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Face Count

Whenever you create geometry in 3ds Max, you should always be aware of, and careful of, the
number of faces that an individual object or the overall scene employs. This is important for
several reasons:

« High face counts take more memory. The larger the scene, the more evident this becomes,
especially when you open a scene, or render it.

« Applications such as games have tight controls on how many faces a character or a prop can use.
If the face count is too high, it affects the smoothness of the game play.

« Face counts affect render times and advanced lighting calculations, such as radiosity. When there
are more faces, the calculations take longer.





